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1.3 4

e 24 4 10/100 BASE-TX H Zhril & Jk LL A M 35 11
* 24-10/100/1000BASE-T HahfiillFJk (gigabit) PLIAMAZHeuh 1
o 2 /N (SFP) Gigabit 3 1 #5#e4% f#% (GBIC)

e 802.1D/802.1w & EAM#E (transparent bridge)/ 4 i #iX (spanning
tree protocol)/ ‘B A= Wi i (rapid spanning tree protocol)

o 8K MAC Mk 2277 Ko i {4 F 1l i) & AL Bt 8]

« 802.3x i &l

o BT 802.1Q #rid (tagged) W HEHIFIM (VLAN) » £ X+ 256 4
VLAN

o HETUHOR VLAN

e FLH VLAN

o 802.1p 54 - M0G0 R 4 MBS

o I IGMP il (v1/v2)

o R ASAREREA

+ 802.3ad #%II IR (F3h'5 LACP) » s ZAIHF 156 Mrhgeirdl

o iM% (Port Mirroring) M

o 802.1X E:T Uiy 1 Y X 2 15 [ 428 il

» RADIUS L iAER A P RS

N YN Lk ki

o ¥HI1%4 (Port Security) HfE

o DIKMZLEi21E

« DHCP % i

o RERELY : HiH,SkiE MAC HubkisE4% » VLAN {h4E4% » IPv4
ToS/DiffServ » IPv6 i &% %% (Traffic Class)

* RMON: X#F 4 MHA (1, 2, 3, 9)
o SNMP v1, v2, v3 fa2 [ 44 bl
o S MIB-II & B FE

o Al ARG E A R E (MIB)
o FTP AT EMHHALSHEER7

o RAZILH (Syslog.)

o WTIEEMA P R (GUID)

 LED $8/m 4T AT B 0E RS
« LED 8T AT B8 RGRTES
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& 2. BIER
& 1: BIER#RT G LED #8747
FR7R Be K7 iR
SYSTEM Rfa, fH 5% A EER A
IN#R BB s s F
e |lER S ERIER
JEK T HL IR ALY
10/100/1000 |45, ER E#3. RJ-45 & SFP ## ; iHg
port status Ja
IN#R IEFEAE % s OBUR
JEK FoLAK M 8
10/100/1000 |44, ER Ik O A E %8 1000Mbps
port speed 8 10/100 ww O /) 7% % B F N4
100Mbps
I |lER TJkom O HEH 34 100Mbps
SRR HEHGHEN 10Mbps i RiE#E
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ARALHHLE ) AR5 A — AL REAR AL -

&0
[o®
L3
&
30

A 3. |FER
x 2: FEWRIRT
TV 35t BB
Power connector FEFRH R
1.6 FAHE
* 3 HEARYE
YR~ 43.5mm(H) X 444 mm(W) X 180mm(D)
iR #iA : 100-240V AC/2A 50-60Hz
FHEE <GB0 R
IMEE K BT T
0 -40°C -25 - 70°C
(32-104°C) [(-13-158°C)
5-90% 0-95%
e 10,000ft  |HE 40,0001t
(3,000m) (12,000m)
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221 EEZ|HBEEDSBEN

T DUGE F LUK I 0Ks B ~ 4 245 (hub) B3H At 38 # W% 32 2 A S e AL Y
S 1o ST LR P B A a5 SO UK P e i 4K 4B o

BAEHE 5 KPR L FiEHE 1000BASE-T i o & » 15
S IEFRTEIA B 1Gbps °

2.2.2 EEHIEZL

LK AC FRLJREG Y — i i B B A AL T AR A FRL AR AL - SRR M FRLIR AR Y 55
— iy A ) FEL YA EE

2AKIRER 4 R BT AR K9 LED $8/~4THRZS o # LED f8/R4T 5858
i - MR B AIREFE IR R 21T -

% 4: LED #5747

No LED 15408
FASE (4 00 (R A L EL 2 TF B « W15 LED
1 |System KBK - TR B A BB LR 2 75 TE BB 9
¥ 35 HL AR -
o |Switeh ports FASE IR R AN S R D 2
[1] 10 [28] BT o PR FACHNLIEAE A4 2 SO -
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2.3 BT — XHMNEKRFE

20850 BN R Y e FE T o IO TR X A AL AT AT AL E - DA
AT R A EFATIE

o MEEEE @ ATHYURAM TTEHE R W - &0 DIE A Java® IRER
[E5.0 B E mMUARNK AT E - FMUHESEE 3 E55E 4
Z .

2.3 BEEEEIESE (Configuration Manager) BH{TH &

AR HALIE A T — AT 5T 2B 0 P TS T R AR S o FROM D B B A
(Configuration Manager) -

AT DL 5 a2 #e il LAN ui OAE W AERE — & BN B o0 sE4s (a0
Microsoft Internet Explorer® 5.0 5 ¥ & A » A% #F Netscape) SRijj[alEC
HEHR -

1 EBINEN T - ZHHLE M TAER AR o BT BB DURE &
G4 E o AT LIFE System --> Administration TT [ F 5 A8 # AL 14
W TOAIE SN BE -

2. FEM Tty (B 5.0 B0H e ]|
A o RALE TP 8 P o o s

i‘miﬂ: . http://l92.168.1.1 i 1S IER 11

JFHT <Enter> o X ZACHk: Fhoutn ‘

HLAYERIA TP $tudil: - [T |

SIS H B R - 4 e

K 5 frs ° ™ oe | [ |

3. AR R AR
> SRJEH#H T <OK> - 4
X5 SR ] U B - 1
o P T A RO

AP &#R: admin
ZHY: (EZEL)

& 5. EREH

/ TR BERT B BT -

TR GigaX 1024+ 3 #ril 9



AGRRCE TR P m

it - 3% 5 System > IP
Setup - HAFR P Hb
HE o W% RS S AW

% BRI A <OKD o —
5.4 M a5 AR

> 01U

HLEIR S B 0 o 3 5 S

R T H - X2 E R & 6. IP &

DU o 1 7E P IR A AR
(9 1P Huht - X5 T <Enter> » RIAJ BEH 49 M TR

6. BFFJAM L& U AN IE DI BE - TH AR P ST Administration T > SR /5 1%
# Enabled DIFFJE RS- IR ©
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FIE-FHEEEESR (Configuration Manager )

3 [FABGCEEESE (Configuration Manager )

AAZ MR T — N TIU5E 22 09 R T A T AR RS - BRONED B PR
(Configuration Manager) e ‘& A] L AAKHE P 257 BT & T & - &
DB 53084l LAN 3 1A 3 RO 4T 3 — & B I - A0 0 T 30 98 28 ke 1 [l fic B
RS o

3.1 & F % Configuration Manager

FL A& M4 (Configuration Manager) QUG ZHEE] T AZHAL o EiiIA] X
AR FRR - SRR LT &0

o —BHERFHAL LAN S O RGN - A0PRE 225 1 r 1 Brds

o IRMHIRAZEE T TN BEAY o @ Microsoft Internet Explorer®
5.0 HEERA > XA RURBIRERUER o AL HF Netscape e

B0 DLNATAT — B FIA R Al LAN 35 1 A9 i _E 35 )X A~ AR -
3.1.1 figE Configuration Manager
1 EBAE R T » 2HHLIT R TN E R SRR o ST 3 e LR IE R

GHYZAERE o AT LIFE System --> Administration TT [ FF 5 A8 #4114
W TOAIE SN BE -

EM T MW R (IES. O FE & AR - i A TFIPH IE ¢
http://192.168.1.1 F$&F <Enter> o X ZAZHMALAIBIA IP Mtk - it
A BN R A 5 S T o

'}ﬁ Plaaie 1y0# o unss namse ad Cawod

Faw 1SR Y
MHaar !

Lo Mo |

[T T |

T Sawn e periwod 6 pous Do bl
o | [ |

& 7. Config manager & & & &

LR GigaX 1024i+ Z#adfl 11



FIE-FHBEEEER (Configuration Manager )

3. WA P SRS ER - )5 F<KOK> o 28 S & U Bt -
(RN NN =R

R &#: admin
2= (%)
BREBERRRGHHMEERFEW -

3.1.2 BE—1HH IP bk

1B E —/NFre) IP Hidik » 35 57 System --> IP Setup o AT IP H1

b - MEEFERS S BN G - SR i <OK> -

275HT B Ak S BN AR TR 0 B N 2 SR A B L AR A 7 1 s R B
FHEM T > XORIEFEIL « WM A AR 1P itk - R)5 %

T <Enter> » RIAT S HT A1) TR 7R -

SETT R ML T RIAE I HE > 1 7E3E o sl Administration I - SRJ5 1%

## Enabled DU 5 @RS (-7 I fE -

B IPEE
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FIE-FHEEEESR (Configuration Manager )

3.2 ThEELSHS

P U B DT B = AN AEAL ¢ TOERRS ~ Ze S B S A A o

ThUEpE

ZER L EA

E 10, hEEH

T & T A HALEAS AN AT AR ] - 0] 10 B« sX MG — BT
MR O 7 B R HALRTRARK) LED 87847 « UT KT 4A 18
AT AR & 3 -

o £ A RBFRRITHRINEE X (WL 8 1) -

* £ 5 MmO FE i o

% 5 OB el
mOBeE w3

) PACK R 34 e B 3

i) TELLK M 12

JEHIE i e AT 14T Bl 2E et 25

Ay 1 P BRIV RT T A 7 S s o R PG AR DT

LR GigaX 1024i+ Z#adfl 13



FIE-FHBEEEER (Configuration Manager )

FEMMERL N SEBAE > A T ALY I A7 m] S REFC &
LT o XLETIREC L8047 T 40 9€ » 4N System, Bridge % -
T DA AR AT 20 LR 3% 7 4 e & BT -

A7 AL PR St 7 e B O T S R ] - R i 2
EH 4.8 EHULH -

3.2.1  HSESEBEHEIS

o BRI -AMKMTIRESER - UL ERIE A Y
Bltx -

o BECH AR IIRE
s -

H

FL IENE S I E AT @

322 ERARAS5EIR
TEAG T A TR R T AL S AR TR -
*x 6: B HZASEER

B 11 R

24 Err InRE
[ oK PRAF LN 24 i DT T (A AL T AR T o
Add TERGEHHE— A RICE » S MAC Hitika
IHUER) ACL #U -
Maify By — T EALE -
Remave B SRR E - RS R B s U ACL B 4
| Reload FH RN YETIUA - B OB ST SR s E
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F4E-HEEE

4 iEEEE

AENNET AR EE L (Configuration Manager) " I ThaE -
SO B F A R R E T 2 BTN o X LETHAE A ¢

* &% (System)

o Y3 1 (Physical Interface)
* #i4% (Bridge)

o AT B 45 B TP (SNMP)

o 424> (Security)

o 4512 W (Cable Diagnosis )

o 43t E 3 (Statistical Chart)

o [RIEHCE (Save Configuration)

/ ER XA IREXZ B IIEE (BREE) T BHIHIEE » B
Z Save Configuration T ' $A/5 =i <Save> o

41 R UE (System)

AN AN B E A (Configuration Manager) Hf System T £
RE TP T A4

c WLEREAF  BMAGE » REMEREMALFL

o F55E P Hudik s

« IFa /KM TTNIE S RE

o FH BT HAL ;

o [T+

10 GigaX 1024i+ ZH#adl 15



F4E-HEEHE

41.1 B (Management)

* Model Name: /i & Ff o T ——

e MAC Address: ZZ#:4LH) MAC b 5
i/ o ==

o System Name: JH 45 1 Ik B =
NRGE R A PR G -

o System Contact: 4B &5 E (7]
g ) o

 System Location: RGN 'E (1] % A 12 &8
")

System Name, System Contact K System Location I AREMERF

g

A LIS T + 7 el <OKD « i i <Reload> HeHIA TRTAL -
41.2 IPEEE (IP Setup)

ARAHANR SCRFEh S TP S 1P ik - 3h75 1P sl w] KA — VLAN H)
DHCP g 55 #33kH = IP BCE (1P Setup) WM& & LI R ATACE IS 4L -

e VLAN ID : HRGEMAMIEE VLAN ID - ZEHTEH » VLAN ID &b
B F IR —A4~ VLAN |5 -

* DHCP Client : ¥/ DHCP DAZKHUZhZS 1P Mokt - s <P DHCP SRfs &
A& TP Hudik - DHCP iR 5548 AL T B8 B VLAN 1 > H AT L[] -

* IP Address: AR BHLEE B H 46 € — AN FRAS 1P itk -
o Network Mask : M 2% fEhd
o Default Gateway : BRI\ 3%

BRI AR S i sy <OKD> o fifi <Reload> HHIAL & -

16 10 GigaX 1024i+ Z#adl



F4E-HEEE

41.3 EERPR (Administration )

EHALPR (Administration) T Af m

LA S IR BT P A - D —
16 JL P SO P TR RSB FR P - : =
AR RS 8 A - ﬁumnﬁ S
U7 R BT DA —

o Password Protection is: 5 B 3¢
P TTINIE B g

o User Name: HriY f P2 & F% - B 13 EEIR
o Password: i F Y %4 -
« Confirm Password: 5K ki A %Y °

s <Add> SRFEHT Y o SRS MEEUR E A <Modify> - 3 AR
BBRIEER T - s <Remove> e

LRI R - 15817 <OK> o miidi <Reload> HHilCE - AEIET
RO INRE - ST BV R E SR

4.1.4 E#E3N (Reboot)

TR DU 25 Bk H 2 3h A 4L
1. A iy System --> Reboot ° It 2 7~ Reboot T e
2. fiifi <Reboot> ¥4l °

B 14. EF/EED

Jf\ EFEDTANEELAGRENFHERAES -

10 GigaX 1024i+ il 17



F4E-HEEHE

415 EEFHZ (Firmware Upgrade)

ETALA L THOE A i R —

GigaX ZEFEaelac 2 (A4 -
AR RERHHOTE BB
XA RN E R (image) o
il & & # et (Configuration Manager)
AT — P LAY 7 R R AR AT [
Hpfg -

TH KBRS BRI E 1 B 15. EIHA R

SRIF IR B AT+ T -

W] 2 U L R IR

* Hardware Version: ./~ {45 -
 Boot ROM Version: &7n i s IS HIRRA

* Firmware Version: {74 AT AT HY B PERRAS © XSS 2 Bl [ 1 T
i S o

2.7 Firmware or Auto-config file HEHP » i A B UG SCFN B 5 4
oo Gt mT DL s <Browse> A E FR A LG b A 3% [ R 4%

3. miili <Upload> FHE[E 1 » T4 5 MR H 3h R S5 fipl -

/ EXRBENEFENZHY 0 5SE 4.1.4 EF/FFN (Reboot)
s FREOfH IR 2L R B AR BN HHL

£ B E X I & WA A “configbat” » AXHRIE—1TH

WA “#autoconfig” o

18 10 GigaX 1024i+ il
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4.2 Y1iBiw[ (Physical Interface )

#1310 (Physical Interface) En ) =
T LA 5 119 BRBHAR S - 2 e ——

T DATC B v O B DU AL
o Port: PR B E 13
o Admin: 251,/ 3 M O

» Mode: [ig & 3 A FIM T

* Flow Control: /8,3 802.3x
i B AL
+ Port Status Window: {7~ & H B FFIME & -

B 16. YR E

Link Status  |BEATEB IO AT L - IR 09

State B/~ STP (AERM ML) RE
Admin R O 2 H R IR SR A
Mode BN E AP C B P e R I AR

Flow Control Eon 802.3x i B HIALHE I o 8 M

B PO AN DU » 5B AR Y. B 158G - 2B s O BEITIRCE - R
#i <Modify> 1#4l - BWERMEMHEHR R RE O o AT - BAIGT
Save Configuration #1E/5 » A R LEELEARL - 2L 4.9 RERE (Save
Configuration ) #F4>H9UdH -
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4.3 ¥ (Bridge)

##E (Bridge) WHBHHPEE TN ZZRE - MEEKILE (Link
Aggreration) * STP Z1I6[H -

431 B (Spanning Tree)

AR (STP) Bt & T i 18 m
TR RS R A M L ThfE - & o ==
T A& =A% - &
a) {58 (Root Information )
b) STP % & (STP Setting)
c) ¥ % & (Port Setting) -
B 17, £ B

R1EE (Root Information)
BB Bs TR E o FATAT LN TREEAR AL STP 1% & -

STP iZE& (STP Setting)

B ERAE STP iR E - B DIRE DI FIH

« Disable/STP Enable/RSTP Enabled: 71 /& /54 STP/RSTP IhfE - 4T
Ja T STP/RSTP i » EASIAL RIS HAL - W STP/RSTP ¥ H
PIFiEE -

 Hello Time: BPDU A= il B 19 6] Fg -

« Max Age: $EWCE| ) PIXAS SA71E 8 fe KIS E] > B X SRS - K 229t
£

o Forward Delay: % & JEiR -
* Bridge Priority: A2 AL 1E R M Hp A AT S0

#%i%E (Port Setting)

B RmORE - EEET 1M ERED » B Nm O R 4k E -
S <Modify> B STP/RSTP s Hix &  &r] Ak & DL

o Port: EHEFHRER E MO

o Priority:  2ZHHLIm OO E 64k o MUNMOBFACR M E 90 ek o M)
Do 2% 1] B FFDIR LR - A R e i B BB STP #H4 » AR
WEMEN 0 FE 240 -
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 Path Cost: A% EM N 1 & 200000000 » % E K Auto - A%
BT (Path Cost) ¥#% /" fE AdminCost H » iz fT AR T 48
(Path Cost) ## I /R7E OperCost H = 4 (il E B 2% [ B AR LT » B
FREIFE (Cost) Mysh O FTRERE STP #H4 -

 Edge Port: BRIAMEIR T - T A9 O AR W% & Wi 4w 0 (Edge port)
W OS] BPDU JG72528 STP w0 o 3%k 10 - 75 AR 40 19 i fa) 5t
Al AN RS -

« Point to Point: Auto/Yes/No: 4 XX TR A0 ot 11 #9820 58 Sy vt i 422 5 =
At AR A 10 4 4 B A S o s S R A D BRI © FEK
LZBEN T - B E MAuto -

sy <OK> RRAFEEFT A B » sl <Reload> HHIACE -

4.3.2 $EHCE (Link Aggregation)

AT KRB B BB ICRAFAH - & -
b4t 15 MEILRE = =
Ao OB EU T 248 : i i i
e Show Trunk: 1#E#: Add a new Trunk B
R — A - k- EA
FE2H DU R DU RS B S 0 B
bR
e Name: #E4 Ak - & 18. 5B B

o Trunk ID: BT BEH ZFRIN » FHRIX
SARRNCR AR S o

o LACP: FFj8 /36 1k h Ak B4 ) LCAP ThAE - LACP B[ 5 K Active o
* Remove Trunk: #8535 & 1Y H 4k EELH -

» Port lcons: X 83 [ f I b HEAZ B AIL T i Al _E 1 2 B A Y o iy B A ]
PUEHEE R A 01 = FHUC Rty B m ) AR PR A AR R A2 %
s <OK> Al HTTP 55 4 e B 1Lk 2L - Al <Reload> AJ

T E - EAARGEHAE - i5E Save Configuration T ° X5 A i
<Save> °
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/ LR AT BN OL A EMHEE R LR TIZITARE
- HERIFIEE -

% BT EHABENE O TEESEFHE (auto-

z negotiation) HEILE £ X Tzl o XA EF A sERE HERX T
TCIEHE - BRI OFE NEHFI 2R THE - WAEMmOWLFA
BHEEIBEE - & B EL EIE1TRE KT A -

/ B BB B R i O R B 16EHT VAN BLE -

/ #E R L BB AR TR OB A A — MBI EE - 2 -

e MBFT—PMEHARRBEMNT B RN EHEZ K -
GIgn - Betp& T BERAGIERO 1 MmO 2 - ZixO 1 A9 VLAN
2HZ - Wi 2 B9 VLAN tREZ 525 o

RGP e RN T - DI R P B A T RS - R
Y138 (Physical Interface ) 1 runtime status B 1R 7 B0 20k i 11 1 7 24
X o EITA R4k AL 5ER R A MR A B R 5 2 W TR > XS4k T
WIS o FHA — AR B HIE ) R e e W T WAk R A
IEFREESE « TEH FP AR 09 e Al 52 BRI B M AR R B e 5 e W T -

4.3.3 1% (Mirroring)

Bl - AT - L e —

Zum O E R 5EARM - :

» Mirror Mode: J& a2k fl ik e B4l
M BEIRIIBE -

» Monitor Port: #2035 5 19851505 O
B A i 1 A5 1 Bl -

L]

e

B
=

B 19. £ TE
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% BEROTEEE F MR ERAE - MIEROTEER —RZ

£ Bl O—HIZIT c EXBEHTHEZHEMUFES] o KX
?ﬁ‘ﬁlﬁ%}'z’gﬂﬁ 8 POt ITHE G » HHE G I 2 K ir1C
untag)fy °

sdr <OK> it HTTP 55 #% K Be B A5 15 22l » sl <Reload> H] 3
HBCE -

4.3.4 FE7SLE#E (Static Multicast )

AT - A LU AL e —
NETE TIE RS SR s —

127 A - e |

LR S 0 AL 0 28 R
HAbs O -

« Show Group: %# Add a new
Group SREV.—AHIHE » Sk

o MAC Address: HE# 2 &Ml -
o VLAN: ## VLAN B4 -
B <OK> RAFFT AR o i <Reload> BHALE -

4.3.5 IGMP fiilfr (IGMP Snooping )

LT IGMP (e ] | —

IR BB DM R IR IR R » AR =
TREFFJERS - sC AL St IGMP | = e
A IR IR AR5 % - =

BRE - —B#SMbEmE S AT 4

#B 256 AHisikZSE) 0 IGMP il

BN LR EWIBTT - AR A

256 2B -

mass meas sams
EEEE BEeE BEEE EEEE
= (=]

& 21. IGMP 1707
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436 #EES| (Bandwidth Control)

#E95#5 (bandwidth control) TR -

) BT 128 7 B4 T 9 P R o AR AT AL
PUBEAN i 0 0 SERE SCHRR LI fE - S8
RECE DAL

BN B e ==

(Ingress bandwidth control ) e
o Port: IEBFEFHEREMmO B 22. FEEE

o Control: KM,/ F Bk Amw FE 15
THITIRE -

¢ Mode:
e Bcast: FR#IH#EHE o
o Bcast, Mcast: FR#il] #5 & 5 5 HREEE -

o Bcast, Mcast, DIif: FR#I#&5H0 « HiEEHu5 B A9t 52001
B —FRE

o All: BR&IFTA R E -

o Limit Rate: A &M B EEORBIE - Hln - BHB T #%, 4
LRI TIRE - AR B R i B R RE R T BRI BR HIE - A
A EETEEN 70 & 250000(Kbps) °

fEH HFR 4] (Egress bandwidth control )
o Port: IEFFHEELEN WO -
« Control: e[,/ JE & i SE 4= I ThRE
o Limit Rate: fig K& - ARHIACE(EVERY 70 £ 250000(Kbps) ©

mif <OK> At HTTP RS#HKIEHLERRLHM - S <Reload> T]
FHAE - EAAGEHEE » 5% Save Configuraton T * K5 Sdv
<Save> °
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4.3.7 zh7stbil ( Dynamic Addresses )

AT AR BRETHO » VLAN 1D [ ]
5 MAC Hifib kA #k3hZs MAC ik i e ——
&R - AP EN MAC ik | =

FRushAstt - ERAEENTE R &R | ‘B

B Aging Time FrikE B0 LU

A= 15 & 3825 (PAfLRF) [H] it

BB R % B HAFTERA] (SR &bt

[E) o & <OK> AJ{RFERTEA T

FT B B A AR T o LK A R AE BT D B 23. szt
& & Save Configuration T *

SRIG i <Save> ©

A MAC Hihk - &ATLLA% port ~ VLAN ID 3 MAC address * F£#i A
MR HME - ARG S5 <Query> o HuhEBT 4G BR B FREE 5 -

4.3.8 Ea7sHbit (Static Addresses)

RTUE A MAC ki EH R&idHE
b - B¥—EHFETHHILES - 57 B
F6 H At b R P RS o = =

HAHhE (Static  Addresses) TiH
ARCE TS5

e MAC Address: #i A MAC M
e

o VLAN ID: iy A MAC it )& #9
VLAN ID o

« Port Selection: #&4% MAC Huhlkfrf@myug M -

« Discard on: 2§ MAC #tutibAF 5 H sttt i BLAE B G - BmT DL AT

B 24. gstbtit

B #RIES MAC el

mii <Add> o FRY T E K B BEIEE O H o B ik E O R 2 LER
15 AIH » HABIHE ¥ TR 2R o S First, Previous, Next 8%
Last FI I YEHI 2R 1 45> DU e

B — MAC it
PR ETEE R MAC #ihl - )5 S <Modify> -
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BB—1 MAC it
PR ETEERRN MAC il » SRS & <Remove> o

EH—1 MAC ik

A MAC Hifit5 VLAN ID - 885 st <Query> - #r4k 45 Kbl BnEHb
biRzinlecit

Bl <OK> IR IBTEA LA T T A2« &7 <Reload> T B HALE -
BUK AETEHTELE » 1% Save Configuration T * $XJ5 S <Saved> e

4.3.9 VLAN

4.3.9.1 VLAN #zt, (VLAN Mode)

RSP PIRT VAN B 2 (D) 3T e e

WA VLAN (Port-Based VLAN) -
(2) 802.1Q #rid VLAN (802.1Q

Tagged VLAN) o ASstlllE i | —
RS FX AN IhaE > BT ERE '

PLTRA

a) Port: 75 B E AW -

b) VLAN Mode (VLAN &%) B 25. VLAN #3t

e« 802.1Q Tagged VLAN: KM
802.1Q Tagged VLAN [#HLIN kA i i R B 5E -

» Port-Based VLAN: %5 052 2 T O B9 VLAN 8= - W 1) 4% um 02
WEIFRIC (Tagged) HEET @ KK 802.1Q Tagged VLAN BYHLINIK
MR RYE » 2) HiZu 0B S RbRiE (Untagged) HHERT - KK
18 Port-Based VLAN R HLIU Skt s & UL 5 -

FR i
o H—ANUmONETEOR  VLAN B B¥REERUN — MR 24 1
(promiscuous port) * WARREAT 802.1x 5 IGMP il »
o gk (Trunk) AELHUE AR R VLAN 5 -

il <OK> AR BTEAR LA AT B T A2« 57 <Reload> T B HiBLE -
Bk AMETEHTECE » 35 & Save Configuration TLH » X5 & i <Save> -
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4.3.9.2 #%i2 VLAN (Tagged VLAN)

BALRERS 237 4 VLAN F | —

B HFEXANTEER - KHWE— =
AR VLAN o X —IhAEm i |-
LA A EF BT o BT ERIAW
VLAN1 PI4bh o e IR BR AT |

— kAR VLAN - -
ST DL D 5 EL R A B o 0 oh B

Frid (tagged) i AKFrid (untagged)

b N € i 2 TR e < R B

HIHZ 4

o U7 type: FARCHINR O o MiZim &4 R HE S BER VLAN 45
it (tag) ©

o “T7 type:r BN O ZIXH) B A HRSHARIT ©

o “plank” type: A [1FF3E VLAN AR A -

HAb T & A

* Show VLAN: B RifsE fIEA VLAN -

e Name: VLAN £&#5K

 VLAN ID: 24857 — ) VLAN B » P 35 275X B A VLAN ID -

o Remove VLAN: B — A K VLAN o XMREAIFER L H VLAN AR
S -

e Private VLAN: 43X~ VLAN % A%, 4A VLAN (PVLAN) - PVLAN it
fABARY VLAN BCE » 528 VLAN 224 - R4 A0 L/ VLAN f
IP BIRIHFE » T IRBAHFEAY VLAN 224 o ARG FHZRIAAY VLAN
(VLAN 1) fENFLE VLAN (PVLAN) - ERTM ARG H - W H 4 4
PVLAN - S8 Ihfie s i W dsums O KRR PVLAN B - #RSdH iR
REER AT PVLAN o —/4~ PVLAN HAFMu 0L © 1) BLumn0
(Promiscuous Port) 2) &m0 (Isolated Port) -

a) Promiscuous Port: —/~ PVLAN 240 HAX AT #IA — MEZ 10 - B 5
PVLAN WA 8 o W FiRZm 0 o B R &

o TR ZR N AN AR AR IC U
o Wik (Trunked) ¥fi 1 RBEVE MR 2% 1 (promiscuous) ©

o BN AfEZBITTET U O VLAN (Port-Based VLAN) ##
ﬁ o

AAnA BoAR ASAR
- (==

B 26. t7iE VLAN
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b) Isolated Port: PVLAN 1) 4EiEZ% (non-promiscuous) ¥ &5 [F
— VLAN A HEAMG O7ES —E2 T emEn - [LaE5i% PVLAN
AR 2% 815 » PVLAN CEREFIRR TR DR & 2 SN T A 1%
KRR ORI E o WS O &R BT R E R0 -
I B S R o X FRR R O - A AR ¢

o PR O U FORPRC R B« 25 B8 B DRI C B &

BHEFR -
o [EEHEOLEE/E T —4 VLAN » At VLAN Wi Rh#4 VLAN
(PVLAN) -

o RS O ANREREAT IGMP ity -

e Priority Override: 241%64% T priority override(L S/ EE) » 2T VLAN ID
WG HREE (priority override) REMUE T4 VLAN J i » 245
HIIRERT - A M VLAN ID BRI E AR5 (priority ) BAA0KBE E
BoNFTECE WAL e 8 - VLAN priority override BYE5EZ% Hhif O
BRI SR B TP IS s -

o Priority: £ HREE (priority override) HWEEFE » XMEFAREE S
. VLAN ID A8 3¢ AR ATt 1) 8 56 2% -

FZARAELE VLAN B RK IR 802.1Q Tagged VLAN [ HL I S fify % % pe 5 »

Bt A VLAN Mode 1T FFi%#F 802.1Q Tagged VLAN B {E Hyix £

uE O AL R B VLAN Mode ©

Aifi <OK> mladsd HTTP R 55 #F AL B %1% 2L - fiidi <Reload> 7]
FHAE - EAAGEHEE » 5% Save Configuration T * S5 Sidv
<Save> °

4.3.9.3 EF#OH VLAN (Port-Based VLAN)

FET 08 VLAN(Port-Based VLAN) m

EKEEME MAC HltRS5HMH = T —
K o OOk B R R E | = 1
B VLAN  iX & & fa] 50 Al B W WL Y g e

VLANER - E—4EFmOK
VLAN - REEH R A 38 E 28 Hhl
Hu O BARER VLAN B4 - 763X
AT o AR E RS 28 M3
FuOK VLAN B4 - HHeils A 27. BFiO6 VLAN

e Show Port-Based VLAN: 4% Add a new VLAN 3R#E 7 — N EE4 -
SRR — AR R BELE DU R T AL AL O AR
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o Name: BEZH 45K -

* Group ID: 4 & 7 — ASHT Y 2L T3 19 VLAN I X M7 77 2 A
#41 ID (Group ID) ~ AZLMHFAL ID A 1 2 28 -

» Remove Group: Bk — A E T OM VLAN B4 - AREf7ERE
FHET IO VLAN EALHH -

HEMIEH RN ET W OK VLAN A% - S451%8 VLAN Mode T i%
# Port-Based VLAN U AE X #oi 0 A A Y VLAN Mode ©

s <OK> Whlid HTTP MRS #IGACE Lk B8l - S <Reload> 7]
FHEE - Bk AMEHEE - 5% Save Configuration T1H * K5 A
<Save> °

4310 EIA#O VLAN 5 CoS (Default Port VLAN and CoS)
FUEAE THEMHIE VLAN fF e e
AR N E - XK ETE = — ;
Lk =
o Port: 875 EACE 1Y i ==
o PVID: #ETFIUROAMVLAN ID » X

M O BIREI & — DS Ririd i

FHEESIRC XA VLAN #4
ID - & 28. BtiliO VLAN 5 CoS

o CoS (Class of Service) value: Mix4>
vt DU BN & — A RARIE R B R S 9TE 2tk CoS HEBIFREH VLAN
o

s Modify> ¥ HF MR OFIRE DR BRINA - S <OK> alid@
HTTP R4 8K IC B 1515 A8 HAL o s <Reload> W HEHECH ° BAAMR
FHEE » 1§ % Save Configuration 1A * ARJ5 s <Save> -
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4.4  BEMNEZEEHIL (SNMP)
TR A 2% B MY (SNMP) 7] FSRE M 2% o AT DA SNMP it & 11
ESRIFJE 85 ] SNMP IIEE »

SNMPv3 AIE4LTE L (19428 HAI 426 - SNMP BA FHI &2
3 :

441 F#2H%|R (Community Table)

T LA AR R B R T T A i

JETEHE SR AR EEABR - & =
i <OK> REFMED ST <Reload> T =
TOH LT © :

s 29. B¥H
4.4.2 FHFIFER (Host Table) 29, FAASIR

RTUEW EVIPH ik 5 B4 5 %
(Community Table) T IE A 1 BE
HARELE R - A~ P #b
HEH T E B R BB 2R o o
i <OK> RAFIC & 3 S <Reload> &
LA -

& 30. W FFE
443 Trap Bt& (Trap Setting)

R rop B P T P —
HAEFR  BaIJFf8 SNMP trap I = e —
fie » BIEARRMA (v1 B v2o) B | = i i e
trap o S <OK> {RAFHCE B S . :

ifi <Reload> H# T ° _— =

& 31. Trap BLE
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444 VACM ##2H (VACM Group)

VACM (View-based Access Control m

Model » EEFAARA U REHRIERD) B =
Y] FRACE SNMPv3 VACM #4l | —- -

f5a - = M=

VACM Group TLHA THIFEENS
¥ S

 Group Name: #ij A\ 224 ZFK -

* Read View Name: i A BEL BT 11132 K 52. VACM ##
BB %% (Read View Name) e
IR SNMP 1588 Get, GetNext, GetBulk °

e Write View Name: i ABEALITE I E AR 24K (Write View Name) o
XA SNMP 58 R Set -

* Notify View Name: it A B2 A7 J& A8 HAE M 2 Fx (Notify View Name ) -
Ay SNMP 158~ Trap, Report e

* Security Model: % A FE2HL TR 1) 22 2 (Security Model) ° Any i@ Al
F v1,v2,v3 - USM |55 SNMPv3 i3 -

* Security level: #i A TR 2% 9% (Security level) - RIIERINE B
NoAuth * AuthNopriv 5 AuthPriv e

ﬁﬁ <Add> BLEESL— A VACM BEH - BRSHR—MEAR) VACM B

s B RERRABAFET <Remove> - EHEH —MIIH - HEEFEH
%Ea‘fﬁﬁ’ﬁﬁﬁ I T <Modify> « sy <OK> W] {774 T 1 B ey Bl o ok it
<Reload> AT EHACHE - BAAMRFHBECE » i§E Save Configuration T
SRJG S <Save> ©

445 VACM &4 (VACM View )

VACM KL IR EE SNMPV3 VACM [
B ER - . T ———
VACM ##l (VACM View) T {3

ERrEE S

» View Name: §ii A 2 REH £ FF - e

o View Type: Hii ARt & e it
KM (View TYDG) o WK TR 33. VACM #31
(View Subtree) 5 SNMPv3 {4 & 33 il
Y OID MfFAR » EHEES (n-
cluded) =iHEBE (Excluded) -
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* View Subtree: fii AR (View) FT)@IAMF# (View Subtree) &F% °
F# (Subtree)fe—4~ Oid » 'B5 SNMPv3 {5 B+ 1Y Oid T4 © 4TFR
5T SNMPv3 (FEH1 Oid B » HEIFHFASIRE -

* View Mask: i AR (View) FFJ@ KM (View Mask) - RS 1 &
— P RFETHRMFR (View Subtree) HAEMB LR AE S ZAHHTE
Mk 00 RARLPHE -

it <Add> ATHEN — MHHVACM Bl (View) TTH « BRSER — 4B 1
H o SEEHEBRKIIHE T <Remove> « BLHH —AMNMEAMWIH » 1
FEE ML T Modify> o ST <OK> A R FE % T AT il « &
i <Reload> FIEHACE - ZKAMRFHACHE > 1% Save Configuration 1T
[ > $8)5 A <Save>

446 USM AF (USM User)

USM Fii/* (USM User) EEFIRE |

E SNMPv3 USM }Eﬁ)ﬂ%‘a ° - e —— s ——

USM A/ (USM User) IEEE T = = )
Iz .

» Engine Id: MIAFFAEMGH ID B = =
Engine ID -

o Name: & I i AFF & Engine
ID #4%5 Engine ID l— P& %4
f}’]‘; °

o Auth Protocol: #ij A Engine ID 5 & # /& Auth Protocol » fEiX 24+ H
BEPERE NoAuth, MD5, SHA1 ° #EEEHE T NoAuth » W Tek A %Y »

o Auth Password: #ii A Auth Protocol ffJ@ &g » 753% B 3002 5 /b
I\ B B B

¢ Priv Protocol: #i A Engine ID 5 &% /@) Priv Protocol © 7EiX 24 H
fB1%4F NoPriv ,DES  # %+ T NoPriv » WG A %Y

e Priv Password: #i A Priv Protocol @[5 55 o 7E3% B8 i it B0\
P EF B F A o

miif <Add> DAgES— AN USM AP IE - 2Rk — A TE - SR
ERBRMKAHE T <Remove> » W B —MEARIE - LR EEHN
K FF 3T Modify> o gy <OK> mJ R A% T AT s ek - S <Reload>
TEHAE - EARARAHAE > X Save Configuration TUH » #4857
<Save> °

& 34. USM
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45 &% (Security)

AL R 802.1x T um LAY &4 TAE o HUAZIER EAUA T PLT) A
AL o R B ARZENIEZ AR R A PR BT - IMER 55T i RADIUS
i 55 5 B HAIL A St K50 2 4 L

ARSI FFEE 802.1x IAMIERYZhZA VLAN 4hiC - S+ HP 4w A [
{5 B AHETT IR A REZ AT - AE NI 55 &% Db AT RCE -

451 wwmOFEES (Port Access Control)

i 17l (Port Access Control ) m
T FskECE 802.1x &% - 802.1x f# = e —
il RADIUS/TACACS+ i aaiA |- o
B PE SR IR S B | = =
u DA SIA AR E - R E

(Bridge Setting) S 0% & (Port

Setting) -

vy . . 35, .w..D e _;:"%I
H#Ei% 8 (Bridge Setting) [ 35. i eI

MR ETTHEE THIRE S :

 Reauthentication : FF /A4 H J5 » A2 #4276 B HAERA] (ReAuthenti-
cation Time) 2|i - K E EH LR ORI H P -

o Reauthentication Time : # “Reauthentication” T H &.FF /5 » ReAuthenti-
cation Time (EHINIERTE ) 8RR ASHA EH & B INIEE R 2w 0 P
RS

o Authentication Method : AJLL{#i I RADIUS A #b##i ZEI\E S 0 89
Fl o

* Quiet Period: 5 )\ RADIUS =A< b £ FEIAIE R » A2 LR & 3% IR
TSR O P R B R A HS ]

* Retransmission Time: #5 1 F ' AR BE B W AZ AL & H R IAIEIE R - 38 8AL
TR R ENIEE R E) %06 0 P AT ZEE R -

o Max Reauthentication Attempts: 2 Ui 1/ AR HE [F] W A H L & H K AGIE
TR WL E Hr R AR R R B -
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#%igE (Port setting)
WO ENHEE FIKESE :
o Port: 5 E T B E M IHH -

« AuthMode(Authentication Mode): #1%# T Port_based » M40 H
A — A FEM (host) MitiEfE RADIUS JR4#% ~ EfE TACACS+ IR
5w B A 1A P BOHE FE B IAE © Port_based 2 £ £ £4L (Multi-host) K&
GuestVID » £ TMAC_based * &4~ T ALIE U 0] W 26 2 Aij 4B 0 20058 1
TAMIE « MAC_based ARZ#F%Z EAL (Multi-host) K GuestVID » R&i
LA % H 256 A2l MAC_based 3Bt AR £ o Bk T
MAC_based » @I B #i% & F 1 Reauthentication TiH -

o AuthCtrl (Authentication Control): %1% T Force_authorized » 1% 7€ B9 Vi
O AN R FE GE - B - REFE EVLE I 2808 RiFEnt - &
N > E¥EFT Force_unauthorized » % & i O 2B 81 - A SRR
Bl o AEET Auto » HEEWOMSITER 802.1x WHkREEH -

o Mutrhost: FFEAINH J5 » REERREEm O MTE EP - A —FiHid
TR - WA R R0 bR O 1) FAVER AT DUEE FaX AN O o 5 A
WiH > WA @ GERIBER LA UE XA O o T Auth Mode
%R T MAC_based » IR HE Multi-host ©

e GuestVID: ii& VLAN (Guest VLAN) 1] f0iF3E 802.1x & P & fi
YA 32 PR A 25 17 (Rl BLFR -

A <OK> AIMRAFHEE o A <Reload> W HEFHE - A ALEHEE -
1% & Save Configuration T1H » SR /5 S <Saved e

45.2 ¥ NFAPRF (Dialln User)

# AJH P (Dial-in User) 10k E m
MARHAARHEAREF AT © B | e —
HEETIIRESH : =

o User Name: #09 F 2 &85 »

* Password: # il ) %14 - == =

o Confirm Password: B0k AR5 LA
TRIA ©

e Dynamic VLAN: Hf8E—"ofi4
802.1x MR E F i) VLAN ID »

B 36. ENFF
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s <Add> HSLETRI T o BRI - R Modify> o 5 EE R
Br—MEEM AP s Remove> o il <OK> fRIFELE » #iifi <Reload>
HHECE -

45.3 RADIUS

FHEMASNES RADIUS MR4s @ & = =
TEREUTSH : ._ -::__:____d
* Authentication Server IP: RADIUS = SE———

IR 5545/ 1P $todik o

» Authentication Server Port: RADIUS
5545 i T e 9 0 154G

« Authentication Server Key: iX4~4: & 37. RADIUS
I RRALE GigaX 32415 RADIUS
Mk 55 #% 2 A AT 38 AT -

 Confirm Authentication Key: F i A &8 LATRIA ©

s <OK> RFALE - Sifi <Reload> EHACE » TR AMFEAE @ BE
Save Configuration TL [ * $X)5 S <Save> °

/ EEFZHYIE] RADIUS IREBUFEE G EIERE W TRE—
4~ VLAN A ©

45.4 ix[O%%E (Port Security )

U 0 224 (Port security) WHE @S T DAL E (port configuration) » ¥
FRZS (port status) DLz 224s MAC Hilit (secure MAC addresses) FE °

45.4.1 wOFE (Port Configuration)

2T T R i 1 %24 (Port Security) m
R ZN B - AR Z T = T—

1024 4424 MAC Mk - AP AT DAl | = = O = LR

B OB AT Ti 5

e Port: IEBFFHEMEMN IO - e

o Admin: M1/ IF 53 O B 242 Y)

&b
Ae °

* Violation Mode: AT R & 24 i

B 38. i Of &
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R AT E R O ShE o FRPRG A R ZeRE
1) HitkZHELF M T RKREENZ4E MAC il > mEA —4 MAC
HhE AR AE T bR 1915 s A ) 1 e
2) £ — A2 4 1 N2 S TS e AL B bk 7E Rl — VLAN 58 —4%
Sy OB o ] DU & S 0 78 E X 24T B IR = At
a) Protect: TEXMEERT - S E R ZETE N FH4LER > BEAR
LB A o
b) Restrict: FEX MR » YA SR LA BN HFLEN - %S
BH - W - RGEHSICFE R » Violation H4gs A SE 2880 -
c) Shutdown: FEXMEET - Ui RS2 RN AR BUEMBUIR S - REH L%
—A~ SNMP trap 30715 H » Violation 428 i $0{E < #n -
o Max MAC Addresses: Fit & %24 MAC k8% KEE - ARETEE M 1

£ 132 Brf 1 X AME B SR AUNT 85 T A B ALY %2 MAC
Hohk ) e KRB -

e Aging Time: Bt & E{LATE (aging time) - ARETEEMN 0 £ 1440045
) o BAVHIT SIS MAC Mtk A% - #BHEECE A 0 - WA I B
Uit 1 B EAL WL

o Aging Type: ZALKRI e E T4 %4 MAC itk #4405 shE - B0t
FEPIFh 2RI AL 2K HY -

a) Absolute: ¥ [ A 224 bk 76 # AL ISR B 5 S Wi ReBR -

b) Inactivity: # fEHEE I A N BCA R B 1Z %4 MAC MR E - Ui%
WohtA 2 WIRERR -
TEFEAR R 3 SRS AT RCE - SRR A E Modify> « SR8 1A A A

SHIEHNENHEE - A <Reload> T HFALE o TR AR HAC
H » 1% 42 Save Configuration T1H » SR/ S <Saved e
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45.4.2 uAIRE (Port Status)

ATHER T HARD RO ZEE (i

E‘ , @?ﬁu‘l\“yﬁﬁ : - m
* Port: i 1545 o
* Status:

a) NoOper: F/nui O L2 U RER
BHHE -

b) SecureUp: /ni 0 @£ ez B 39, mORE
T -

¢) SecureDown: R 1 K& HRETCEBFT © XFURIL— B ATFE T
u &2 EE > Hl THREHERE (n5HEMmIhgerhs) miikERiz
17 e

d) Restrict: F&/R{E Violation mode Bt & K 'restrict” B » s B T H K
GEMERRE -

e) Shutdown: F£/R7E Violation mode fit & &"Shutdown” Wt » 35 0 HIBL T
R AR E BRI -

o Restart: &G EHIFEAT shutdown JRET B3 L (Yes/No) e
* TotaMacAddrCount: XA # & 5 8)& %4 MAC #ulk i) S0 -
« StaticMacAddrCount: 4R # 7 %4 MAC Mty 4L -
* ViolationCount: i X % 4 it & HAF A S 4K -
MRG0 B %2R SecureDown ¢

o Uil FRJESRE -

o B P UM RS 1 G
i O b 4k O o
3 1 R AR T REh Y MR o 1 o
o ¥ O IEFEET 802.1x » HiBfTFRENMAT -

o O BPRZS R Shutdown » P AT LSS 0 1 56544 Restart it &
A Yes » RJG s Modify> » B/ OMHERSESEH ABHHEE
My <Reload> TR HACE - EAARFHICE » 1§ 2 Save Configuration 71
> S5 7 <Save> e
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4543 24 MAC #tblit (Secure MAC Addresses )

SIATTLLB MAC HUE B0 0 0%

& MAC itk - B XM TR = -

HE MAC Hitib R &N %Z42 MAC Hb -- =
hWER A RIMHREIBESLE |

MAC Hufif -

* MAC Address: %i A MAC it} -

« Port Selection: #£# MAC H#utkIH/E
T B 40. % MAC #ptt

EEF T — S MAC Hlb)g -

Ha T <AdD> o XAFIE ¥ S EBRFEMIEE O HF -

JAP AL Port Selection ik —ANuid - A5 i <Query> » XA 0
VTR T 24 MAC thlib¥ BoRnfe b b o

AT AMBIE AR e — A E > T <Remove> » BRI RS BRI SBEA Y
fudt - HEREEPZAIE - e L Shift 8 0 I RREE 2
OUER

mifi <Add> K <Remove> TIHECE L RIAER o Bk AR X BEHELE
MAC #ifik » &% Save Configuration T » SX)5 &t <Save> e
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4.6 QoS

QoS W AEFEEIRS (trust state) - B} (mapping) - L EE
(priority override) » PL & CoS Zfjfig (CoS function) -

4.6.1 {F{EIKZE (Trust State)

5 A% (Ingress Policy) MfE5 2 [

JBA TS (Queue Controller) 2t =

AW ER - ARZHEILLIFA :

Uity 0 R R S R X — DA o R HTID —_—
BT ¢

o Port: R ERLE MU -

 Trust State: Trust DSCP #{ CoS -

a) Trust CoS: fii i IEEE #rid - &
Wi IEEE 802.3ac #xicii » M|
i | IEEE 802.1p Traffic Class R0 AYEEAE A mi A9 56 4% - 0 -
i FBRIA MR e Bl -

b) Trust DSCP: fi [} IP fE NG « &gy 1P S IPv4 #X - A
IPv4 TOS 5 /8 Diffserv ¥ B FEE A KL 54k 5 ZWily P K
IPv6 X » M A IPv6 Traffic Class R0 EUENE WL ek -
Z) » fd FRBOARI L 56480l - 2T Trust DSCP » MHEMEEA T
Mapping 5 CoS Tl

M <OK> Wit HTTP MRS HCE 535 Eag il o M <Reload> ]

I E - BEAAMGEHEE - /% Save Configuration T - K5 &
<Save> °

B 41. FERE

4.6.2 BH (Mapping)

7% DU F K H DSCP (2 43 Ik 55 %
Fedk o HRLH) DSCP EHislEl 0 & e

63 o XfF IPv6 » DSCP Il 4 15

F 1) 2 i B S % (Traffic Class)[{E °

%40 - DSCP {8 4 %3 IPv6 E%

2% (Traffic Class) WIfE N 16 B H

Folic & DL - BIAT T 8 AC LAY

XATfE B 42. B gt
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« DSCP: i#%#¢ DSCP {# -
o CoS: 1%+ CoS sk -

i <OK> mfid HTTP R 55 49K 0 B L% 8L - S <Reload> 1]
HHAE o« EAAGRTEHEE » #5E Save Configuration T » S5 S
<Save> °

46.3 MLERETS (Priority Override )

fL4edk EE (Priority Override) T

A iEEIF B8 e H QoS kiE MAC = I T —
ML EZESHE M MAC #hik |- S
MAFEE - = S

LI T R IE MAC ik # 5 (priority
override) TRE » FTKIE MAC HutikAY
T 5E 4% B 5 D RE X B A v AR K »
BN HERFKRIE MAC #ilit52%
MEFHS MAC HittFEHHOHEET
e MAC $thhk30 H AHE A - B
SPATHRIE MAC ML REREE o YEEXMIRMRE » f3ELFE ARL
RSP BE K B R BT L BB - SRIE MAC #ulb e R ES
Iﬁﬁﬁﬂ"]%f’ﬁé&%%?ﬁﬂﬁ@?ﬁﬁ\ﬁﬁ%é& ~IP 5k - B VLAN fReRhEES
Tite -

FHIAT B MAC MiitiE B EE IR - £ T B MAC Hisikfy it %
BEEIREN BT A i AR - Y- EEE M MAC it 52/ Nz
A MAC ik FFPIFEFE THEHA MAC sl E RN - RI&HiT
HAgH MAC Ml e ES - BEAXFMIRIN > 4TS ARL £
WEFEER S R IR e EE - Byt MAC ittt BLEEY)
REMRSEgR B m N - EE S T OBk ~ 1P 584 ~ VLAN £
RREE » DI EORIE MAC Mt %R EEIRE -

AR BEE I AN MAC T H B A CoS 1564k » i % Static Addresses
TUH °

M OK> Wit HTTP RE#HIGHE BEE R - ST <Reload> 1]
EHAE - EAARTEHEE > 5% Save Configuration T » SRJ5 S
<Save> °

B 43. fLERET

40 10 GigaX 1024i+ il



F4E-HEEE

46.4 CoS

A RO 4 ey, T —

B SR RASEE DL T B T K

Strict priority scheduling: &1~ CoS

{E AT WL 3 PO ASBA ] 22 — - BAF 4

BAE R ERREHEQ -

AL e F i = A7 = iR

Fe R BN B R 2B A e B AL ik o 1E

Strict priority scheduling 7= F » B 44. CoS
W (weight) KB AE o

Weighted round-robin (WRR) scheduling: WRR (AL EEFHERF ) 75254
18 & — NEUFEE A Z A SIAXS F HAR CoS BAFIAYEH HAEE (ML) - WRR
] By 1 FE A& = A e B\ A I R AR AR S SR A B 58 4 g B AR DL -
WRR HiFH5e NEA S {3k — e dt - Lk EaE R T4
MW AFI R EEREE » BN - ARSI — AL (weight) A 1 BAFIZHIAL
(weight) H 2 MER MG — L% —AEE - WBFI (X WAE -
X FHET 7 o BV S SE R AT I RSB R FI A Bl &0k
fEIEE - IR ETUN 1, 2,4, 8

My <OK> Flilid HTTP IR 555K BC & (5 B2 et - S <Reload> W]
FHEE - Bk AMRGEHBE - EE Save Configuration TLIH » A5 &M
<Save> °
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4.7 #4852 (Cable Diagnosis )

45151 (Cable  Diagnosis) f 32 m
DrRE R i e 1% (FF S s B ) = == —
FR A M AR AL E - Bbabh » k88 | ™
ZWTRER T Ll PHY 288 (10M, B
100M 3 1000M) DA K Al — i £k 4

HIBE o K EMMThREO R T

JeH R

AT 158 > I35 T <Go> - |l [& 45. 45581
R R - g

/ LT R ORI 552 Wi ThEE - M2 B2 - U DRI M 45 1%
~ EE = -

4.8 it BElE (Statistics Chart)

it EER (Traffic Chart) JUE A DATERF W EI R B E - &L
6 8 R GEVEE R RIS RN RN o ARk S TT I A - 4T DU AR A B 26 ok i 45
ML © KZ% MIB-IL V1 5 AR B R 7E X S K -

Hiil <Auto Refresh> B <Refresh Rate> St B M AT HbL IR BUHT SR A4 st ]
[ - s Auto Refresh i Refresh Rate KD E M 3441 B3 $4is 1) B
AR RG o #RT] DL RE A Fite (Color) 3RIX4AF M O s G itg - &
Ja » R Draw 30545 £ G0 1T B3R « BT Draw B HEBESITHER
BN o

4.8.1 =B (Traffic Comparison)

AT A O — A

BoRLER KR - 455E St i S——

iH - T Draw > Q&4 2R
H 46. 2L B

BB RO RAE - I A B — B I 5 —
R e
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4.8.2 $8i=&¥2H (Error Group)

e M (PorOMLE /R E(Color) » S8
Ja wiili Draw > Git 6 MR R oR4E 58 i
HTA 25 s iR R » X R

O T — |
I — B 2 2 L - E -

B 47. iR BEA

4.8.3 [F X7 (Historical Status)

T LA 3P 2 i R R IR 8 1 FE_I_
ﬂ%wma i T R R S

B SRS - R - RIMEEE
E%ﬁ  FIH R R S REIHE S

o i -

B 48. [FERE

4.9 R7ZELE (Save Configuration )

Bk ARFHE » BFE ST <Save>
A - i <Restore> M EIKE 1= s —
BHBAE - ER] BIAER 0 |=

TR BT i B AR E R -

B 49. RFEE
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%5 & - Pt - MKXELEFH

P Hbdlk « PLZIERL 5+ W)

5.1 IP bt

AET IR ZXTF IPv4 (version 4 of the Internet Protocol) BIAIZ
/ TIRHR IPv6 HEH RIS -

/ AETEELCETHT 3 L4 FHEEMANR -

IP #ulb i iF 18 Internet MASHIHLTE S8Y, M TIX4 Internet AT S
(N M%&) - 4 1P HibusE 4 el §1NSiErERE4EE 0
F 255 ZEAARS W 20.56.0.211 XL [ 7 [ A HOBEFRA
fieldl » field2 - field3 » 1 field4 -

5 P IEH R — R T Z A XA Lﬁ?jaﬁ&ﬁ%ﬂ%%
IP #ihk 20.56.0.211 Ak “ ZFSAANEEH - ——

5.1.1 IP st B9 254

IP ek iR S A SR ARAR IR © 2 EBN] - — A 7 (LAY IS SR
Al 3 AL7RHRE — IR - Hh & BT - B 4 fERRK
S LT A B 5D -

2l - 1P sk E AT AE A -

Mg D
fEInternet 5 Intranet BfIA M2 G -
E#H D

T A 25 Hr aff DA PG 5 B

BA TP HhERY S — R0 &M% 1D » FHARERSNIE 4L ID « M4 ID 1t
FERPT R g p o QLRI AR » £ 7 B 1P sk py ity -
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5 & - Pt ~ MKXELEFX

F 7 IP HhALZEH

Field1 Field2 [Field3 |Field4
A% M 2& 1D FH1LID

B % KM% D [F:#L ID

C % K% 1D [F:#L ID

THRARM 1P ol FEH)

A 25:10.30.6.125 (M4 = 10, F41 = 30.6.125)

B 2%: 129.88.16.49 (M4 = 129.88, F#l = 16.49)
C2£:192.60.201.11 (M = 192.60.201, F#L = 11)

5.1.2 LKA

=R AR A 38 B KM C 3¢ - (FSLERA —FP D KHtdk
(B2 E MR g 5 A TX RIS TRTC K - )X RAENE A 1IfE
FARIERAE -

A KMZIE Internet EHUBLER KR I 25, GAHEAT LAA 160 T FEM - X
R R MR 2 A 126 4> B3R 20 2T - T ENNAER
PER > ik SR 2% F ) 00 25w B 2B 4 1 R AR O 412 - A ISP

B KM A /N BEEABABRL 40 B EM%T A YEL
65,000 ~FA o XEERIMLE —IH 16,384 4> - B RMLE G KTUHL
TR TS T SLEUR AL o

C MR/ - —A C ML REEAY 254 AL - EHREM%E
BEEME T 200 77 (2,097,152 1) - #3# 5] Internet [ /R I M E 72 C

/ Mfield1 AT LLE2 #4238 il il S 2
< field1 = 1-126: A 2%
field1 = 128-191: B 2%
field1 = 192-223:  C 2
(field1 B R/ ATEB 5 B (45 5% Fi%)

/ FH ID ALLESERE 0 #1 255 FOMET(E, iEE BEE
- o
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25 % - IP it - MEEILEFN

5.2 “F##AD

P& B RLE E e {5 Er B A IP $titit, {8 5CER EE B & T —RIIAIEL4F
FoR P LRI ER S E ML ID - BFLEZFYL ID ¢ bbEA 1 &
T XM DT 0 0 K7 EE/EHID” o

T RS SR AE ST 9 CRIRA W 25 53 B /N 93) = — 199 19 ) 4%
ID ZRMENL ID “fEA" SCBLRY o T FIFERS TR B1X L T4 ID i -

2B - AR — A C MMl 192.168.1.4 IFAST M - ki 2 A
T P A

255.255.255.128
B FCR o R R S A e R B
11111111.11111111.11111111.10000000

A% C 25l —FE - fieldl 3| field 3 #RM % ID » (HREEE field 4 5
— AR AR T ID e M THAMY L ERRME (0 1
1) ERMNEETATM - AR ARAN 7 HAEE R EL D, 8
Fl2 0% 127 (MARERE 0 ] 255 By C 2eHbib) -
ALY > Bt — A C R0k 4 AR - JERGER:

255.255.255.192 & 11111111.11111111.11111111.11000000

Field 4 HFHSMIMAFET LA 4 MEQO0 - 0110 11) > FHIL™4T
4 ANFR o BAFRIE AR AN 6 AR E R EN ID > JEERE 0 # 63 -

ﬁ — L F IS AL H AR FNIEIDLL - FEI R B F R4 o
< IXFERIETIFR BN FIHE AL, X L2
AZE: 255.0.0.0
B: 255.255.0.0
CZ: 255.255.255.0
ﬁ&ﬁf&%ﬁuﬁﬁzz‘%E%Mﬁﬁ&&f?ﬂ#&ﬂ?ﬂ#ﬁﬂ%ﬂﬂﬁ%
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% 6 ¥ - ReEHRE

6 FEAEHHE

AT LA T2 WREN 1P TH o [FIHES]H — Sl Ge B
() R B b AR R TT 56

FrACHE  bug CFITER RUHIH - 5 1ERC B AL AT 4RI 521% 5
WY o TSR Tt e 0 A 7 ST TR AR DR D - 15 FRAT 100 2 AT THK &%

61 {E/A IP THESHEM

6.1.1 ping

Ping J& T K6 M5 ) L2 75 RE 5 TR Bl M 2% _E LAY dy % - ping &
] F 2 Y FLIKOE M — 2505 B Rz B I B A AR R, - Bt s Rk m]
B o B ping fir4 > BT ERE TR R BRI Pk -

£ Windows® #fE RGN L - GATLIHTIT s €5 R iz
177 ERSFTRAGSIT:

ping 192.168.1.1

gl WAEY o T DA SR (R A M B A SE RS ) TP btk
B -

AR AR IR TR AME S - mte M BnE 50 FroRfig4RR o

B 50. {£H ping TA
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% 6 = - BeEHR

IR EM RN > & BREE “Request timed out” -

Ping iy 438 ] FIF 0154 2 30 e AL 14 A2 R 53 A7 JC B, (4 L BN 1) SR el )
IP #ifik 192.168.1.1) s H At Aas L Fs & fy stk -

3t AT DL A — AN ERHAE 0 www.yahoo.com (216.115.108.243)
St R T3 A EL B ) B AR R W o IR AR A EEREMALE K 1P H
Bk > ST RU#E A nslookup A4 » X ANAT AN TE T WHEITHER -

XFHABGE R 1P PR ERIE RS - 0] ISR RAT T HRIAERY &+ 50
il ARG T ARSI A4 o

6.1.2 nslookup

AT LA A nslookup i SRk
FE 5 LI il S ARG R I TP Hb
hb o AT RAE E — Al AR
nslookup FFELR DNS ARk %5 #%
33k 1P il (DNS AR %5 2% —
AL TR ISP) » WRZ ZFRA
R ISP B DNS R 55 #5103
SEFR s b E SR S G R
MR 5548 - DABbEHE - HEFREH
HE AR o B AR 55 A8 2 A
M) TP ik A% 25 B0 B L & 51. {& H nslookup TR

St T4 ] Windows® #:4F R45 )
R - 80T DUFTH Frig RE
B C BT REEUARE DA A

nslookup
B ME c BAFERSER-NMEERRFT O)  ERXNMES IR
Ja A TR AL - i1 www.absnews.com © % L4 ERAEXT N A TP #y
ik, 7E 51 R o
Y b —AEIEM ZFRATREXS N AR 24~ TP Hudik > JUE 45 3 2 K 1
B X EBuE SRR 2 IR SRR FEHRINE R -

FLR H nslookup » TEIR AT A exit 3% <Enter> -
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% 6 ¥ - ReEHR

6.2 R4S

& 8. SEEPIHF

BE EDSE:

LED #8747

A% T HE T A B R R i 12 B AC A L B R YA B
SYSTEM LED A%

W 5% B M 20T, Tk | LEIA LUK R RS ER s S bl iE S 21 50 R

(Gigabit) PAKM Link
LED A%

M AL/ S et/ R BN RN/ SR ki A el
B&FTIF -

UMNERBERKERERTFEEMMLEESR - 1000
Mbps M %% (1000BaseTx) Jiff fitrA Cat 5 )%k

45 o 10Mbit/sec W45 0] BB X REEAR AT 2645 -
BESHE]
FEL IR S RE U [A] [R] — ) | LAR RS UK 581 - LEDSE/R AT B R B4R -
N AT
BRNATEL o ynmum g LED f5RT RI0E - KA RO R
EHYEEH -
AOSERIR RS FASTP, R AE 2 H LA ) (4 X 2% I o
FEL i 76 325 B R R T AL | LACHALE FT I im Ot E LB - AL H
B JTERA IP K 192.168.1.1.

AR B IA SRR G B o AR A FL
BOATC B — AR B R E 2B AC AL - 7K A2
BAUIPHUS A B AT AT AT TP ik -

SUNHLIK Ping #RAYASHLML TP » NSRRI - EEE 5
— o
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% 6 = - BeEHR

8. BT
Bk B
¥ U B R

ZR/TSIEM AL E A | LANR R 1B SO 7 AR AR - i =il i
T AR EUERY | 48R “admin” - EEGRES o

FATUH JC ik T 2 B | LEAEE FRE Internet Explorer® v5.5 5 DU iR
7N A EE o N HEE Netscape o R0 5 28 0420
F Javascript® » A X Java® »

2.Ping AL 1P Ml A EERGRE - InH
—ping HEAER - BEBWMEEE > FHIALCE
AR e

X R B AY 8 Bl T AR | BIA ST T Save Configuration T Save Fi¢4H -
ped
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% 6 ¥ - ReEHR

6.3 LESTHXHHNIRE

6.3.1 @i FTP L{&EE 4

TEGRAE A ftpTh Ak K H AT FE 4 T
AR EHIAER PC SASHALAL
FR— VLAN T - 32 bl VLAN
BaARTMITEHRATER  System->
IP setup T1i » S WA CLI fAr
% “net interface show” &R
VID -

1. FFaf& T A mEa e
2. % H 3 8 ok Ol [ 4 BT AE 07
B

[& 52. 18T FTP _Ef2[E]#F

o

3. Ffi4d “ftp <IP Address>” i ZEAHHNFIHIFTPIR %545 » Arld
It IP Mtk A LA IP stk > 20 “ftp 192.192.1.1007 -

A H ARG I 24F5
5. Wi ARG -

6. ffir4 “put <File Name>” e LAZMEM: o U2 N FRYZFR - 4N
“put gx1024i+_2.1.3.2_051026" -

6.3.2 1BiI FTP LEBIEEXH (auto-config file )

EEMEM ftp ThAE K HAMTFEE e
T RN HRIAEN PC 5%
BALA TR — VLAN T o &8
LA VLAN &7 T 00 A
A System --> IP setup T1H ° B
#AT# F CLI 74 “net interface
show” 3RkiE/~ VID °

B shlid B30 (auto-config file)

E—AH CLL AwréMmim
RS o MaX A AL B 53. 181d FTP Lf&H ShER &

LHHUF T L A4 o
L PR AT R e o e
2. ¥ B O A S B ST E AL E -
3. M4 “fto <IP Address>” JfeiEHEEAHMLAFRIIFTPIR 5545 » B LA
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% 6 = - BeEHRE

It IP sk M HALAY TP otk » 40 “ftp 192.192.1.1007 -
4. ARG 455 -
5. Wi ANRGER -

6. Afir4 “put <Fle Name>” 3k_bf&H shit & X1 o SUHFNA I TT LA
T “#autoconfig” FHE - H H SHECE X ZFHRUITR  “configbat”  »
i “put confighat” ©

6.3.3 B FTP &M ERAFKHRE

FEEAER ftp DIRE R HMTTRE 1
THE - AN ER) PC 528140
FF— VLAN T 584l VLAN
BoRTRUE AL System ->
IP setup TUifj - si#nr# A CLI fir
4 “net interface show” k&R
VID -

1. FEmA T RAmEED - B 54. @it FTP S ESHE

2. # H e N R G i B S
FERNLE -

3. ffr4 “ftp <IP Address>” R E AL ET FTP 54 - Frld
It 1P sthhk A LAY TP Hudk - 0 “ftp 192.192.1.1007 -

A. WA RGP AFR
5. Wi ARG -

6. REWE XHREMNBINGFRN “backup” o P I HIX — & F5 ok
B RGBCE - SR DU R 800G BB 4 30F -
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6.3.4 BIX FTP MERZRE
EEEH ftp HRELHMEFREE T —F
At EIAER PC 5N
FfA— VLAN T o Z#4Lf VLAN
BARTMIEHA®EE  System—>
IP setup TITH - s CLI v
4 “net interface  show” RER
VID -

L PR AT R e o e

2. ¥ H SO 8 3hc & SO
FERNRLE

3. Mfird “ftp <IP Address>” RiEH RAHMLA R FTP R55 & » FTLA
It 1P Hhk KA el 1P Mtk - &0 “ftp 192.192.1.100" -

4. HA RGP AR
5. fii A RGEHRD o

6. A4 “put <File Name>” SRWKE RGHLE o MR R — 3 H#t
MR RS &4 S0 n @ “put backup” e

& 55. 1818 FTP hE Z4 I E
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7. RiER

10BASE-T
100BASE-T

1000BASE-T
binary

bit
bps

CoS
DSCP

broadcast

Ethernet

FTP

host
HTTP

ICMP

54

AT LURM A k4 - BiRGH% A 10Mbps ° 18R 3
22k (CAT 3) - 2l Ethernet »

FTLUIRM A Sssi - S fEH%E R 100Mbps © JRK
5 2%k (CAT 5) - 2 I, Ethernet °
FATFLURM A 22k si - S {£H% 8 1000Mbps °
Tt e “HT2” MBEFERSG 0 R 0 1 HAEEF
KRFRITAE P - EdHP o A NEE 1 B 1
F T2 GIE10 -+ ECT 3 BAE1L - 5L
F 4 5{E 100 » R - BIRIPHINE R 7 (& WE R
R BRI o SEbR BE M AR IR - tean 1P
sk 209.191.4.240 #48 —#HE 11010001.10111
111.00000100.11110000 ° H 4% » 1P Hidik » PIZ&H4ERD
[RI AL S Z HE 4 -

b o “THRIEET MEE - AR E - REO,
IFFEENEF - 20 binary °

LR

M52 - 7£802.1Q H#HLE » EMIEHE H0F|T -
2R 5 RAG A

P $t3k A 2550 IR 55358 43 B B 2219 /S L4 FR W DSCP »
GigaX &%|H 0] FfDSCP {4 0, 8, 10, 16, 18, 24,
26, 32, 34, 40, 46,48 fl 56 -

I o R R R IE B M 2% LT A B -

DU o fi e L B4 EEL i ) 2% 5 A, 38 ol PR I & 2% -
DL ) 4 B A2 5 3 2 > 10Mbps AT 1 00Mbps © £ i,
10BASE-T, 100BASE-T, twisted pair °

SO AR

T EHS] Internet 1Y F K 2 [8] 19 SO BA% - & 0L
WATE L AR S E B TR S B0 Sof - IR 548 T
Bt

FHL o HRBIML R SCEFTERMN) -

FHESCAAERMY

HTTP 2 FIRat 17 M 26 508 1% i 19 i 32 B UM > mT A
38 o I T s B R o 2 Dlweb browser, web site °
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IGMP

IGMP Snooping

Internet

intranet

P
IP address

ISP

LAN

LED

MAC address

mask

Multicast

—Fh BRI B - TR H TR S A AR S -
ping fir & W& TR R -
T I5 O FER 2LA BE P

— P LI P o SO RIS R 45l B e 4 AL
FEAR IR, — A PR 2L 425 A 2L sl 2 P 2 P AR B A L A I
AL E I A E B, o T IGMPRFZL %15 20 75 Y .
A ELES SE TR £ ) S A1k 4 R 2% ) B T s B R A B
%o

FEBE U 1 TTIGMPES (3K i 145 = 220 R AL AH G
B o

G > TR S LE e o

AR AR AL - FERE LEM (Internet) ) —#B
S CRP (6 A R T N e e D 1) A7 8. - B A RER AR 24 W]
T A -

%L, TCP/IP -
Internet WHHHE

FAL CEKD) FEEBM Bk - e g T
BAMBERTEE JE0~255 » FI/INECE AR - 4 o
209.191.4.240  —4~ IP #h-fu& TR ID FEHL

ID » M4 1D Fx EHUE TS E R - T4 1D
MG E T FALIME — AR o R HERD IR & XM %%
ID MFEM ID - fF 1P Hidik LML » B ATE HH# X

— M4 (domain name) ° £ I network mask e
o0 25 fik 55 $2 AL T

T A 2 42 44 TL I 7 [P AR 95 4 ]+ JE R 2y -
SRR

FAAET — MRV E T AR 2 - Bl B - p Az e
PN

K ZE
— PR TR B o SCHALRTIE Y46 78 KT LED e
BRI S - RFRMAC Huik

o 71 325 78 20 FIC A 1804 K APERE (Rt » MAC ik i 75
X FAFLLAY

#15 - 2 I network mask °
A o B RIEIE LT —HM & L -
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Mbps

Monitor

network

network mask

NIC

packet

ping

port

protocol

PVLAN
QoS

remote

RJ-45

RMON
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B HEERNGES o W% BRI R ¥ FE R IMbps °
W% o JFFF “Roving Analysis™ » SRV — W45 5347
R B O IR 2 W AT S AL Y He s O

W25 o FEIEBTE— VP B 3L AR (g
PE~ SOPE%E D) —ZLHL I o Mg AT DUR/NELRY » i e ds
M (LAN) » 0] DU KRR - @lanE B -

W25 HERY o L5 HERG LR — R A LU AR 7 58 T IP
HE 0 DL E MK DRI EVLIDRI SR - 1 BRI AiE

R0 OFR/RZMEILHLAE o 25 BIUEIE - IR W 45 1Y
255.255.255.0 A#IIP#i4100.10.50.1 » MZID A
100.10.50 » FHL ID H 1 - &I binary, IP address,
subnet %5 o

CE:E3eRy

1A LN, AN K& O RI-45 FERC A - &
lEthernet * RJ-45

B - FERLE EAERERI AL - B A SR - I
IEEE - e WHE LR ORUEE) Aok 2L (HBY
Hoduht) -

ESRDE Al

FTHRIATP kxS AR B REB Nk - EIRA AT
FHRGH AR TP -

U o WA A B R - AR - B pl A o Kl
AR RRA ©

PR o — BT P Rl A f A LU« O T Kodm aE
PR Kl e ok UEURT H AR R AL R ST A ] B389 A1
o

FLA BB R ™
ik % & (Quality of Service)

7£802.1Q HE X o X THIRBE R AERE - QoSHHEA
HFFE ~ AEIRFTA] FEME o

AR o AIYIHL EAL TR MR o LAl - — ARG A
SN B SR A intranet, fbh 2R

TE Wi E br 45

XA 8-pin A4 S T A R AE AR S B 1Y) » DASK R
L5 A 2 i X R % o
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SNMP HYSE » & BEEx5 R R 45 M LT i -

routing BEE o FEARMM 45 RN BC 2 18] » AR 38 A YR TP st T 2%
T ERRA SN BRE R - PUTE R ERNILE
RN 2R -

SNMP T AL D] 2% 45 2L PR
AT E BRI LA TCP/IP BMY -

STP A AR R
B 1E TR R 2= 2w i A e % B AT 0 -

subnet TP o DR X 2% 1) — B3 > - IR 3 4 2% Y R i

A3 A 7INEL T e 3 28 L i 5 il o 4% Y B o PR TR - T
P Y B iR AT SR FE DB B oA 2 AR - (HIR A
BN AR — DAL 4 © 2 lnetwork mask e

subnet mask TR o ¥ 2 [a) I DAX 43 (38D © 2 Dlnetwork

mask °
TCP Z I, TCP/IP -
TCP/IP FEATAR I AR/ EL I TR

X H M _EFEA AR o TCPH 4 EHE 5> 2 a] DL

EHBEMN PR [P X L% T H Y

otk o 24 TCP #1 1P 5—&b 2 HkATH#45an HTTP,
FTP, Telnet% » TCP/IP $5HH SR EWNA -

Telnet/SSH —FPE BN - DUERE SRR - B U (R i ) R
o HTTP ( B HOF FTP H A i MmFE B il T 3
4 - T Telnet/ SSH FfiF MIGFE & R I FHH AN -

TFTP SNBSS AR S R

—FER SO o TETP kb FTP BiNA S - |
MR AR FTP »

Trunk WA SN DA 3 041008 — RO — AN s O > R
NBERITER -
TTL e ingk|

P #EH—MEAL > P TIZEER A6 - TTL JiAK
/SR RFEENSE] > BUAENE B A T Ron i R B B4
o — BEARTEAE — DBk S - 2 TTL SAERE » 1% E bl
EEi

twisted pair W ZEek o RIS B dil IR 2k - BE S — X s LX) BARgE
LERIHLLL > DUEBR T A2 & o BHAR HLIH 2608 F — X 2% -
HERABLT » BHEEZEMX o X FLUKR R o i
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upstream
VLAN
WAN

Web browser

Web page

Web site
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FH 2 —FhE s » AT 10BASE-TMZ& Y =254k (CAT
3)» DL EE I 100BASE-T M4 2%k (CAT 5) o
%L, 10BASE-T » 100BASE-T : Ethernet ©

EAT o Kol AP L 1 ELEB A ) 7 7)o
HE 0L J5 480
J IR 2%

B 506 T M R P14 S %+
AEF A o AU » SR 4 T
B -

M BT G AE o — FhvE R SO R MY (HTTP) 1 A
TIPS 2R/ E A AF B - X 2(F B ARG S04
BIE - FEErsaif o 9 T SE A6 A TR SO Y
(HTTP) - # MM 11X Y% #5 f24 Netscape Navigator Fl
Microsoft Internet Explorer » Z: ILHTTP, web site °

PR DT o — AR 3 (8 SO o B HE SCA - Mg - FIERE S H
il U A AR AR o 24 AP U R — AN BORAYEE — 1T
A ETL » 20, web site °

PR 3ty o EIBC O 38 3 PR T 0 W e oA AR A P R S R
LA o XUt 8 PR A SOAR 0BG o B BRI I TUA R, © B
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